Drag in Resources

Desktop to Cmap       Desktop to Views       Views to Cmap 

 

From the desktop to an open Cmap:
Resources can be added to concepts on a Cmap by dragging them from the desktop or an open folder.


Once the resource is positioned above the concept and the mouse is released, the "Edit Resource Link" window will appear. If the resource is an image that you would like to set as the background for your Cmap, select the radio button labeled Set as Background. The Description and Keywords boxes allow you to add additional information about your resource. Click OK when you are finished editing the resource link.
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Now when viewing the Cmap, a resource link group icon will appear attached to the concept. The resource link group icon appears with an image that is representative of the type of resources it links to. Each of these icons may list one or more resources of the same type. A concept may have up to 13 different icons attached to it, each icon representing a different type of resource.
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Left-click the resource link group icon to reveal the title of the resource you have just linked to, then move the mouse over the resource's title. A box with the description of that resource will appear.
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Left-click the resource title. CmapTools has an image viewer that will open for common image files. An external program will open for any graphic resource not supported by the image viewer.
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From the "Views - CmapTools" window:
Resources can also be dragged into either "My Cmaps" or "Places" that you have permission to add files to.
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After dragging the resource into the "Views - CmapTools" window, the "Edit Resource Properties" window appears. Click OK when you are finished editing properties for the resource.
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From the "Views - CmapTools" window:
Resources that you have access to from either "My Cmaps" or "Places" can be dragged into a Cmap.
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After dragging the resource from the "Views - CmapTools" window over a concept in a Cmap, the "Adding Resource Links to..." window appears. Click OK to add the resource link to the selected concept on your Cmap.
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Import Resources

Single Resource       Multiple Resources       Internet Shortcuts 

 

From the "Views - CmapTools" window:
To import a single resource, select File then Add Resource(s)...
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Using the "Add Resources" window, you can manually navigate through folders to add resources for use in Cmaps. To locate resources from the "My Cmaps" or "Places", left-click the corresponding button at the top of the window. When the "Add Resources" window is first opened, the contents on the desktop are shown. To return to the desktop view, you may left-click the "Desktop" button at any time. Once you have located a resource you would like to add to a Cmap in the future, highlight it and left-click the Add button.
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After left-clicking Add, the "Edit Resource Properties" window appears. Left-clicking the checkbox in this window allows you create a resource shortcut, rather than copying the actual resource, to the "My Cmaps" folder. Left-click OK when you are finished editing the resource's properties.
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The added resource will now be listed in the "Views - CmapTools" window.
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From the "Add Resources" window:
To add multiple resources at the same time, left-click the plus sign next to Show Resource List. The "Add Resources" window will expand to indicate that more than one resource can now be added to the resource list. Hold down the Ctrl key while left-clicking the title of each resource. Left-click the Add to List button when you have selected the resources you would like to add from the current directory.
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Using the left mouse button to double-click the boxes under the Description and Keywords headings, you may edit the resource properties for more than one resource. To remove a resource from the list, left-click Remove. To make changes to the properties of an individual resource, highlight the resource and left-click the Edit... button. The "Edit Resource Properties" window will open, and any changes will appear in the "Add Resources" window after left-clicking OK. From the "Add Resources" window, left-click Add All to add resources you would like to use in future Cmaps.
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The added resources will now be listed in the "Views - CmapTools" window.
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From the "Views - Cmaptools" window:
You can import internet shortcuts to "My Cmaps" or "Places" that you have permission to store files on. To create an internet shortcut link, begin by selecting Add Web Page... from the File menu.
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The "Add Web Page" window will appear where you can add information to an internet shortcut. Left-click OK to add the web page.
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From the "Views - CmapTools" window:
Now an internet shortcut icon will appear in the folder where you saved it.
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Import Resources

Single Resource       Multiple Resources       Internet Shortcuts 

 

From the "Views - CmapTools" window:
To import a single resource, select File then Add Resource(s)...
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Using the "Add Resources" window, you can manually navigate through folders to add resources for use in Cmaps. To locate resources from the "My Cmaps" or "Places", left-click the corresponding button at the top of the window. When the "Add Resources" window is first opened, the contents on the desktop are shown. To return to the desktop view, you may left-click the "Desktop" button at any time. Once you have located a resource you would like to add to a Cmap in the future, highlight it and left-click the Add button.
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After left-clicking Add, the "Edit Resource Properties" window appears. Left-clicking the checkbox in this window allows you create a resource shortcut, rather than copying the actual resource, to the "My Cmaps" folder. Left-click OK when you are finished editing the resource's properties.
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The added resource will now be listed in the "Views - CmapTools" window.
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From the "Add Resources" window:
To add multiple resources at the same time, left-click the plus sign next to Show Resource List. The "Add Resources" window will expand to indicate that more than one resource can now be added to the resource list. Hold down the Ctrl key while left-clicking the title of each resource. Left-click the Add to List button when you have selected the resources you would like to add from the current directory.
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Using the left mouse button to double-click the boxes under the Description and Keywords headings, you may edit the resource properties for more than one resource. To remove a resource from the list, left-click Remove. To make changes to the properties of an individual resource, highlight the resource and left-click the Edit... button. The "Edit Resource Properties" window will open, and any changes will appear in the "Add Resources" window after left-clicking OK. From the "Add Resources" window, left-click Add All to add resources you would like to use in future Cmaps.
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The added resources will now be listed in the "Views - CmapTools" window.
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From the "Views - Cmaptools" window:
You can import internet shortcuts to "My Cmaps" or "Places" that you have permission to store files on. To create an internet shortcut link, begin by selecting Add Web Page... from the File menu.
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The "Add Web Page" window will appear where you can add information to an internet shortcut. Left-click OK to add the web page.
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From the "Views - CmapTools" window:
Now an internet shortcut icon will appear in the folder where you saved it.
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Add & Edit Links to Resources

  

 

From an open Cmap:
To add a resource link, begin by left-clicking a concept you want to link with a resource.

[image: image29.png]Anatomy of a Plant

Fle Edt Format Colaborate Took Window Help

9 Do v

Tm e

have

=S

Roots

G





Select Edit then Add & Edit Links to Resources... from the menu bar. (You can also perform this action by right-clicking the selected concept, then left-clicking on Add & Edit Links to Resources... from the menu that appears. Pressing Ctrl+r while a concept is selected is a third option you may use.)
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Using the "Editing Resource Links for [...]" window, you can manually navigate through folders to add resource links to concepts in Cmaps. The "Editing Resource Links for [...]" window is very similar to the "Add Resources" window (described in the help section Import Resources) because multiple resource links may be added and managed in one location. Once you have located the resources you want linked to the selected concept, highlight them and left-click Add to List.
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Left-click the box under Description to add or change the description of the selected resource. Remove may be used to remove a resource link from the list. To make further changes to the resource link, highlight the resource and left-click the Edit... button. The "Edit Resource Link" window will open (described in the help section Drag in Resources). Any changes made in the "Edit Resource Link" window will appear in the "Edit Resource Links for [...]" window after left-clicking OK. Left-click the Update button when you are finished editing the selected concept's resource links.
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Now when viewing the Cmap, a resource link group icon (described in the help section Drag in Resources) will appear attached to the concept. When the resource link group icon is left-clicked, it will reveal a selectable list of resources that have been added to the concept. 
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Manage Existing Resource Links

Individual Resource Link       Resource Link Group 

 

From an open Cmap:
To manage an individual resource link, click on its resource link group icon (described in the help section Drag in Resources). After a list of resource links is revealed, right-click (control-click for Mac users) the title of a particular resource link to select it.

[image: image34.png]@ AnatomyofaPlant  CJaE)

Fle Edt Format Colaborate Took Window Help

9 Jal v

r ——





A menu will appear allowing you to cut, copy, delete, or edit the resource link. Click Copy to copy the link so that you may paste it (see below) to additional concepts. Click Delete to remove a resource link from the group. You can also edit the resource link using Add & Edit Links to Resources... (described in the help section Add & Edit Links to Resources). Our example will show how to transfer a resource link from one concept to another using Cut.
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The icon that linked an image resource to the concept "Roots" has been removed because the resource link that was cut was the only one in the group. Select the concept that you want the resource to link to, then select Paste from the Edit menu. Paste is also used to attach resource links that have been copied. (Another way to paste a resource link is to select a concept, then press Ctrl+v)
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Now, the icon and the resource link have moved to a different concept.
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From an open Cmap:
To manage an entire resource link group, click to select a resource link group's icon, then select from one of the options in the Edit menu.
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